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The goal of this document is to provide guidelines for designing camera trap surveys whose overall goal 
is estimating the total number and density of snow leopard populations. The key principle behind 
planning your camera trap survey is that we will be using spatial capture-recapture (SCR) methods to 
estimate snow leopard numbers and densities. SCR methods are likely to give more precise, unbiased 
estimates if the data collected by camera traps has certain good properties. Although we can’t know 
what data we will collect in advance, we give our data the best chance of having these good properties 
by following a set of guidelines. The rest of this document describes all this in more detail, but 
remember the overall goal – to generate good input data for SCR methods. 
 
Guideline 0: Begin by defining your study region/region of interest. 
 
The study region is the entire area that you want to draw conclusions about.  It is not the same as the 
area covered by camera traps. For a small study region of a few hundred square kilometers, it will 
usually be possible to place camera traps so that they cover the whole study region. But with larger 
study regions (>1000km2), it may not always be possible to cover the whole area with camera traps, and 
the decision about where to place traps becomes important. The study region should always be chosen 
first, before deciding where to place cameras.  
 
Guideline 1: Camera arrays should cover an area at least several times the size of a snow leopard 
home range 
 
Distances between cameras provide the SCR model with information about how the probability of 
seeing an animal at a camera decreases as an animal’s activity centre gets further away from that 
camera. If camera arrays cover too small an area, it becomes impossible to get detections at different 
distances that animals are travelling, and this creates problems for the estimation of the detection 
function.  
 



Camera arrays must cover an area bigger than the size of a snow leopard home range, and should 
preferably be several times as large (perhaps 2-5 times). Estimates of snow leopard home range size 
vary from 80-700km2, so camera arrays should cover 400 km2 as an absolute minimum, and preferably 
at least 1000 km2. If using a clustered design1, each cluster must cover 400 km2 (preferably more). 
 
Guideline 2: Most cameras should be spaced 2-5km (1-2 sigma) apart.  
 
We get better estimates of density and abundance with bigger sample sizes. For SCR models, sample 
sizes mainly means recaptures – observing the same snow leopard at different camera traps. Cameras 
should therefore be spaced so that individuals have a high probability of being detected on more than 
one camera and a low probability of being detected on all cameras. Experience suggests that most 
cameras should be between 3-5km of another camera.  
 
Guideline 3: Use a regular grid design if possible 
 
Placing cameras in a regular grid configuration with cameras spaced 1-2 sigma apart (2-5km for snow 
leopards) is a good, robust default option. Often this is not possible for snow leopard surveys, because 
some terrain is not accessible, but it is still worth keeping in mind as a goal.  
 
Guideline 4: Sample across habitat gradients  
 
An initial decision needs to be made about whether your SCR model will model density as constant over 
the study region, or whether you will model density as depending on habitat. If you are treating density 
as constant, then cameras should be placed at random across the study region, or in a regular grid with 
a random starting point (taking into account the other guidelines). 
 
Most of the time however, snow leopards are known to be more common in certain kinds of habitat, for 
example rugged mountain areas, and it makes sense to use this information. An important guideline is 
that if you are going to use any habitat information, then you need to place cameras across different 
levels of that habitat (for example, also in less rugged grassland areas) so that you can test your 
assumptions about what habitat is favourable and avoid biased estimates.  
 
The reason for this guideline is that if you only place cameras in one type of habitat (e.g. rugged areas), 
then you cannot include that covariate in your SCR model because all your sampled locations have the 
same or similar kinds of values. The big problem with this is that if you can’t include ruggedness in the 
SCR model, this means assuming density is constant across the entire survey region. However, you know 
that this is not true, because you have only sampled the most favourable habitats. The result is that 
estimates are likely to be biased.  
 

 
1 More than two camera traps placed within a close distance from each other (spaced at less than 1 sigma), thus 
making a cluster; and several such clusters covering the entire study area. 



 
 

Figure 1: Camera traps should be place in both high and low density areas of the study region of interest 
 
Guideline 5: Place cameras near scrapes, marking sites, ridge paths, valley paths, etc 
 
The previous guideline should be used to choose representative parts of the study where cameras will 
be placed. Usually this will be represented by a small grid cell of 1x1km or 2x2km. Once these have been 
selected, cameras should be set up within each grid cell so that any snow leopards occupying these 
areas are as likely as possible to be photographed. This means placing cameras in places that are most 
likely to capture high-quality snow leopard images, for example near scrapes, marking sites, ridge paths, 
valley paths etc.  
 
Guideline 6: Check expected numbers of detections and recaptures with simulation 
 
If too few unique animals or recaptures are detected, SCR models cannot be used. Guidelines suggest 
that at least 10 unique animals and 10-15 recaptures at different cameras are required. Unfortunately, 
snow leopards are difficult to survey, and often the numbers of detections can be close to this 
minimum. It is important to use simulation tools (See secrdesign app below) to check the expected 
sample sizes for proposed survey. If the expected sample sizes are close to the minimum, the number of 
cameras and/or survey duration should be extended. Teams can use simulations with information about 
the SCR parameters from pilot studies or other similar habitats.  
 
Using the secrdesign app 
 
The secrdesign app was created by Murray Efford, creator of the R package secr and secrdesign. The 
goal of the app is to allow you to check the expected sample sizes for any proposed camera array. This 
gives you a way of checking that your proposed design will gather sufficient data to use SCR later on. 
This document is meant to accompany the mini-manual (https://github.com/iandurbach/camera-trap-
tips/blob/master/cheatsheets/micro-design/micro-cheatsheet.pdf) and describes the steps followed in 
the four screenshots at the right of the mini-manual. 
 



Start the app by entering https://www.stats.otago.ac.nz/secrdesignapp/ into your web browser. Other 
start-up options are on the cheatsheet, but this is the easiest one. 
 
Panel 1: Load mask 
 
The first step is to load your habitat mask, which in this case contains your study region.  

1. Click the “Habitat Mask” tab from the left-hand menu, then select the “File” option, and then 
click “Browse”.  

2. Select the file with your stored habitat mask. You can either use your own habitat mask (you will 
need to create this beforehand) or use the example mask at 
https://github.com/iandurbach/camera-trap-tips/blob/master/examples/example_mask.txt 

3. . If everything works, you will then see the mask appear in a window to the right of the 
“Browse” button, and some summary information will appear in another box to the right of that.  

 
Panel 2: Provide rough estimates of secr parameters 
 
In order to calculate expected sample sizes, you need to provide the app with some information on 
animal density and expected encounter rates in your study region.  

1. Click the “Design” tab from the left-hand menu.  
2. Enter possible values into the boxes “D (animals/ha)”, “lambda0”, and “sigma (m)”. Leave the 

“Detection function” as HHN unless you have reason to change this. It can be difficult to provide 
values here if you are working in a new area, but the important thing is to experiment with 
different possible values and check that your sample sizes remain good under all or most 
possible values. For many snow leopard surveys, densities are around 0.001 animals/ha 
(1/100km2), sigma is approximately 2000-5000m.  To get a rough estimate for lambda0, 
estimate the probability of detecting a snow leopard whose activity centre is exactly at a camera 
location at least once during the survey. Call this g0. Then lambda0 = -ln(1-g0). Remember that 
g0 can be quite low, because snow leopards move around and so may not spend much time at 
their activity centres. For example, if there’s a 20% chance of detecting an animal whose centre 
of activity is at a camera location, then lambda0 = -ln(1-0.2)=0.22. 

3. For standard camera trap surveys, click on the drop-down menu labelled “Detector type” and 
choose the “count” option. This means that the same animal can be detected multiple times at 
each camera per survey occasion, and each camera can detect multiple animals per occasion. 
Usually this is the case for camera trap surveys. 

4. Set the number of occasions in the “General” box. For count detectors only, detections can be 
aggregated over occasions, so the entire survey can often be considered as one survey occasion. 

 
Panel 3: Specify your camera trap locations 
 
We now tell the app where we would like to place cameras, and the app provides information about the 
quality of that survey design. Camera locations can either be specified from file, or some simple designs 



like regular grids can be generated by the app itself. At this stage, we are still in the “Design” tab of the 
app. 
 
If you have your own file with camera locations: 

1. Click “File” in the “Detector Array” panel, and then “Browse”.  
2. Select the file with your stored camera locations. You can either use your own file (you will need 

to create this beforehand) or use the example trap file at 
https://github.com/iandurbach/camera-trap-tips/blob/master/examples/example_array.txt. If 
successfully loaded, you will now see the camera positions displayed in the window in the 
bottom-right of the screen.  

 
If you want the app to generate a regular grid of camera locations:  

1. You will first need to create a “boundary file”. This is a shape file containing all possible locations 
where cameras can go, which will usually be a smaller area than the habitat mask. The habitat 
mask contains all areas that are potentially covered by our cameras. This is all possible camera 
locations, plus a “buffer region” (because each camera can detect snow leopards 3-4sigma 
away, except in the case of hard boundaries). Select “Region” in the “Detector Array” tab. 

2. Click “Browse”, and select your boundary file. You can either use your own file or use the 
example trap file at https://github.com/iandurbach/camera-trap-
tips/blob/master/examples/example_boundary.shp/prj/dbf/shx. Note that you need to select 
select the four component files (.shp, .dbf, .prj, and .shx) at the same time. 

3. Choose the “Systematic” tab.  
4. Specify a desired spacing (between 1 and 2 sigma) in the “Spacing (m)” box.  
5. Tick the Random origin box to generate a random starting point. If successfully loaded, you will 

now see the camera positions displayed in the window in the bottom-right of the screen. 
6. You can now inspect expected sample sizes and survey quality metrics in the “Results” tab. A 

good CV is less than 20%, while 25% is reasonable. If you have a CV > 30%, consider using more 
cameras, as confidence intervals will be very wide. The “Popn” tab shows a simulated animal 
population, while the “Pxy” shows the probability of detection from each point in the habitat 
mask. These can be checked to see that everything looks sensible.  

7. Save detector locations using the “Save” button visible after you click the “Array” tab in the 
Results window. 

 
Panel 4: Perform final checks with simulation 
 
The results from the previous stage are based on approximations. They are very good for exploring 
possible designs, but because they are approximations, they may have some errors in them. The best 
way to check your design is with simulation, but this can take a long time to run, so it is more 
appropriate for the final stage of checking, rather than exploring. 
 

1. Select the “Simulation” tab from the left-hand menu. 



2. Select “Newton-Raphson” from the “Maximization method” options. Specify at least 20 in the 
“Replicates” box for final tests. Click the “Click to execute” button to run the simulations.  

3. Once these have run, output appears in the “Results” window. You can compare the results 
obtained with simulation to those obtained in the previous step. If there is a difference, trust 
the simulations! 


